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To use the Interactive Edition, you must have the following applications installed on
your computer: Adobe Acrobat Reader, and Apple QuickTime (check the minimum
recommended system requirements for the appropriate versions for your computer).
For your convenience, we have provided these applications on the CD-ROM.

Please note that the CD-ROM contains everything you need to run the Interactive
Edition. In order to use the Weblinks feature however, you MUST have a Web browser
application installed on your computer and you MUST be connected to the Internet.

= Check minimum recommended system requirements.

= Go to Installation Instructions.
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Minimum Recommended System Requirements

Windows

Windows 95, Windows 98, or Windows NT 4.0 with Service Pack 3 or later, 486 or Pentium
processor-based personal computer, 16 MB of RAM (24 MB recommended), Sound Blaster or
compatible sound card and speakers, CD-ROM drive (4x speed or faster), Adobe Acrobat Reader
4.0 (provided), Apple QuickTime 3.0 (3.02 provided), Netscape Communicator 4.01 or higher, or
Internet Explorer 4.01 or higher, high-speed modem or other fast Internet connection.

Note: Although not optimal, the Interactive Edition will run on Windows 3.1. Users must
have Acrobat Reader 3.01 and QuickTime for Windows 2.1.2 installed on their computer
(both provided, see installation instructions).

Macintosh

Power Macintosh computer, Apple System Software version 7.5 or later, at least 16 MB of
RAM, 8 MB of available hard-disk space. Adobe Acrobat Reader 4.0 (provided), Apple
QuickTime 3.0 (3.02 provided), Netscape Communicator 4.01 or higher, or Internet Explorer
4.01 or higher, high-speed modem or other fast Internet connection.

BACK MAIN
MENU



Installation Instructions

Windows95, Windows98, or WindowsNT

1. Insert the Interactive Edition CD-ROM into the CD-ROM drive. The first time you use the
Interactive Edition, the Installation Checklist screen will appear. If the Installation Checklist
screen does NOT appear, go to the Start Menu and select Run. Enter D:\setup.exe and click
OK. (If your CD-ROM is not the D drive, substitute the appropriate drive letter.)

2. If necessary, click item one (Adobe Acrobat Reader version 4.0) to begin installation.
Follow the on-screen instructions until installation is complete.

3. If necessary, click item two (QuickTime for Windows version 3.02) to begin installation.
Follow the on-screen instructions until installation is complete.

4. Click item three (Interactive Edition) to install and launch the program.

5. To run the Interactive Edition program at a later time, simply insert the CD-ROM and the
program will automatically begin.

6. If you accidentally quit the program during use, or the program does not automatically
begin when you insert the CD-ROM, go to the Start menu and select the Interactive
Edition from the Programs menu. You must have the CD-ROM inserted in your computer
to run the program.

Windows 3.1

1. From Program Manager, choose Run from the File menu.
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Enter D:\Absetup.exe and click OK. (If your CD-ROM is not the D drive, substitute the
appropriate drive letter.)

Click (1) Install Adobe Acrobat Reader and follow the on-screen instructions until installa-
tion is complete.

Click (2) Install Apple QuickTime for Windows and follow the on-screen instructions until
installation is complete.

Click (3) Install Interactive Edition.

Click Start Interactive Edition (from the installation screen) or double-click on the
Interactive Edition shortcut icon to launch the program.

To run the Interactive Edition program at a later time, go to the Start menu and select it
from the Programs menu. Or, run Absetup.exe and click on Start Interactive Edition. You
must have the CD-ROM inserted in your computer to run the program.

Macintosh

1.

Insert the Interactive Edition into the CD-ROM drive. Double-click (1) Install Reader 4.0.
Follow the on-screen instructions. When installation is complete, click the Quit button to
close the Acrobat installation program and proceed to the next step. Note: It is not neces-
sary to restart your computer until you have completed Step 2.

Double-click (2) Install QuickTime 3.02. Follow the on-screen instructions. When installa-
tion is complete, restart your computer.

Insert the CD-ROM and Double-click on (3) Start Interactive Edition to launch the pro-
gram.
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Accessing the Weblinks
I
M To use the Weblinks feature, you must first

locate and select a Web browser. (Note: you

“iew

Link Information: | Control Key To Show =] MUST have a Web browser application

I Show Toolber Bition installed on your computer to open

™ Show Progress Dialog Weblinks and you MUST be connected to

the Internet). In Acrobat Reader, select

REON EIDAE B ACERT File>Preferences>Weblink. In the Weblink

| CAPROGRAMNETSCAPE.EXE Browse.. Preferences dialog box, click Browse
Connection Type:  [Netscape 2030  w| ol (Select on Macintosh). Locate and select a
E—— Web browser application and click Open.
0K Cancel | Weblinks clicked thereafter will automati-

cally open your browser application.
(Macintosh users note that the dialog box is
slightly different in appearance.)
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g I
m m m You will see several buttons located at the

top of every page.

T R Contents opens a list of chapters. Click on a
R TR s i s chapter to go to it.
Index opens the Media Index.
Help opens this guide.
FIER
"'-u.,._} _.tr“ _d
' I
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Using Acrobat Reader

You will be using the Acrobat Reader appli-

M T > €« 3 I cation to view the chapters of the

Interactive Edition. The Acrobat Reader con-
trols are intuitive and easy to use.The tool-
bar buttons allow you to move forward and

|0 DEFENREDOnOE - VR |

: 1{[ Baoe T backward through the pages, and to change
gAY the size of the pages at any time.
: '. - Note: Acrobat Reader comes with a
_--\{ I : detailed online guide.To access this, click on
@ Tove the Help pull-down menu at any time and

select Reader Online Guide.

= See a description of the
Acrobat Reader Toolbar
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The Acrobat Reader Toolbar

The Acrobat Reader controls are intuitive and easy to use. Here are the control buttons and a
brief description of their functions:

Selects the Displays the Makes the current page

text selection tool last page fit inside the window
Selects the Displays the Returns to the Displays the
hand tool previous page next view find dialog

AN | /
@R T >« OO0 44

l--..‘ |
Selects the Displays the Sets the zoom of the
zoom-in tool next page document to 100%
. Makes the visible width of the
?ilr?:I::;:he s:::itt):s“\]lieew current page fit inside the window
-_— _—
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Using the Media Links

I
'WEBLINK| The Interactive Edition uses audio, video, Web
S sites, practice tests, and activities to enhance
ATl "’ = e EI!E]E]]I the understanding of important concepts,

people, or events. Throughout the Interactive
Edition, you will find icons next to passages of
text, or highlighted words within the text. To
find out more about how the Media Links
work, click on an item below:

= Web Links

& s » Video Links

el
w I‘\-‘nrl
STl |

» Audio Links

» Activity Links

» Practice Tests
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Web links

| MEIRE PR LAY LS NG R T HEIGE

L [2) (2 [SIETSTAT S

W EBLINK

:::--ﬁ::-:flrhwn | [t | [_rrwe [ merwr |
"'T*-"Ea};‘: l _ i Click on a Web link icon to go to a World
%ﬁiﬁﬂ'jjl 'E Wide Web location. (Note: you MUST have a
FmE L witis Web browser application installed on your
computer to open Web links and you MUST
_‘J,J be connected to the Internet). All Web links
Crsiru e R soumiv SR T R H00M are first routed to the Allyn & Bacon Web
S Eoliigh server, where they will be periodically
ﬁ- chi it updated as some Web sites become obso-
SAULLILS LD Gl lete and new ones become available.When a
T i 1 b b ceess . 3.3 e s Web link icon is clicked for the first time, you
i Ity ot Sl B S e may need to locate and select a Web
Alye &, Rucea s 8 Mtating peblishr o1 4T browser.
e bt "' *" e 3 = Show me how to locate and

select a Web Browser.
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Locating and Selecting a Web browser

Webink Preferences AR

Vigw File>Preferences>Weblink. In the Weblink
Link Information: | Cantrol Key To Show -l Preferences dialog box, click Browse

I Show Toolbar Button (Select on Macintosh). Locate and select a
™ Show Progress Dislog Web browser application and click Open.

Weblinks clicked thereafter will automati-

YW Broweser Application . .
cally open your browser application.

| C\PROGRAMWNETSCAPE EXE bl (Macintosh users note that the dialog box is
Connection Type |Her5-: ape 2.0/3.0 _ﬂ il Sllghtly different in appearance.)
0. Cancal |
- _
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Video Links

BACK

VIDEG=

When a Video link icon is clicked, a window
will appear and a video clip will begin to
play. (Note: You must have QuickTime
installed on your computer to view the
video clips.)

Use the video controls (at the bottom of
the video window) to pause, stop, fast-for-
ward or rewind the video clip.

= |nstructions for installing
QuickTime.
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Audio Links

-

et g gy imber g b e e When an Audio link icon is clicked (or high-

E!EJI!ﬂ _ ~wiannl  lighted words), an audio clip will begin to
s e T T e e play. (Note: You must have QuickTime

e ch installed on your computer to hear the

audio clips.) Use the controls to pause, stop,

. - — fast-forward, or rewind the audio clip.

Gr::wth of terary culfure

Kl e el

»= Instructions for installing
QuickTime.
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Activity Links

] Wi thape! Mberailive Edibion
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When an Activity link icon is clicked, a file
will open in a new Web browser window.
(Note: You must have a Web browser applica-
tion installed on your computer to open
Activities. You do NOT have to be connected
to the Internet.) You may be asked if you
want to set your Web browser to open for
ALL Activities.

= Show me how set my Web
Browser to open for ALL
Activities.
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Setting Your Web Browser to open
Automatically
You may see this message when an Activity icon is clicked.

Selecting All will set your Web browser to open automati-
cally each time an Activity icon is clicked.

Acrobatl Reader o

'l Acrobatis sbout to launch this application: C:\Program
: Files\Metscape’\Navigator\Frogram’\netscape.axe. Allow this
acton (yes) or all actions to all applications (all)?

Ho All
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Practice Tests
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When a Practice Test icon is clicked, a file will
open in a new Web browser window. (Note:
You must have a Web browser application
installed on your computer to open a
Practice Test. You do NOT have to be con-
nected to the Internet.) You may be asked if
you want to set your Web browser to open
for ALL Practice Tests.

= Show me how set my Web
Browser to open for ALL
Practice Tests.
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Setting Your Web Browser to open
Automatically
You may see this message when a Practice Test icon is

clicked. Selecting All will set your Web browser to open
automatically each time a Practice Test icon is clicked.

Acrobat Reader »

: '1 Acrobat is aboutto launch this application: C:\Program
E Files\MetzcapaiMavigator\Frogram\netscape axa. Allaw this
action (yes) or all actions to all applications (ally?

Mo Al | |
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Using the Media Index

The Media Index is a convenient way to access all of the
media elements available in the Interactive Edition. When
the Media Index is open you will see a list of links and the
page number on which they appear.

To open a link, click on the item highlighted in blue. To
go to the place in the book where this link occurs, click the
page number in red.

Select a Chapter

HEHEBEDBEDEBREEREDNERHBAEDBE
il

CHAPTER TWO: Cognitive Development and Language

CLICK ONTO CLICK ONTO

GO TO PAGE OPEN FILE LINK DESCRIPTION
Page 25 Weblink Human Development
Page 25 Video Cognitive Development and the Brain

\

Clicking on Clicking on
goes to page opens link
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Contacting Allyn and Bacon

If you come across a Weblink that appears to have moved or become
obsolete, let us know and we can fix it. We also welcome any feedback
you have on the Interactive Edition!

Mail: Allyn & Bacon Interactive
160 Gould Street
Needham Heights, MA 02494

Phone: (888) 306-7267

Fax: (781) 455-1353

E-mail: ABInteract@AOL.com

WWWw: http://www.abacon.com/faq
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